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Preface

Oracle Application Express End User's Guide offers an introduction to using Oracle 
Application Express applications from an end user’s perspective. This guide explains 
how to use Websheets and interactive reports as well as use applications that include 
the ability to upload data.

To learn more about developing Oracle Application Express applications, see Oracle 
Database 2 Day + Application Express Developer's Guide and "Quick Start" in Oracle 
Application Express Application Builder User's Guide.

Topics:
■ Topic Overview

■ Audience

■ Documentation Accessibility

■ Related Documents

■ Conventions

Topic Overview
This document contains the following sections:

Audience
Oracle Application Express End User's Guide is intended for end users who running 
Oracle Application Express applications. To use this guide, you must have a general 
understanding of relational database concepts and an understanding of the operating 
system environment under which you are running Oracle Application Express.

Title Description

About Oracle Application Express Offers a brief introduction to the Oracle Application 
Express development environment.

Using Websheets Offers an overview of Oracle Application Express 
Websheet applications.

Using Interactive Reports Offers an overview of using Oracle Application Express 
interactive reports. 

About Uploading Data Describes how to import data into an Oracle Application 
Express application using an existing application Data 
Loading Wizard. 
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Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

Related Documents
For more information, see these Oracle resources:

■ Oracle Application Express Release Notes

■ Oracle Application Express Installation Guide

■ Oracle Database 2 Day + Application Express Developer's Guide

■ Oracle Application Express Application Builder User's Guide

■ Oracle Application Express Administration Guide

■ Oracle Application Express SQL Workshop Guide

■ Oracle Application Express API Reference

■ Oracle Application Express Migration Guide

For additional Oracle Application Express application examples, go to the Learning 
Library. Search for free online training content, including Oracle by Example (OBE), 
demos, and tutorials. To access the Oracle Learning Library, go to:

http://www.oracle.com/technetwork/tutorials/index.html

Printed documentation is available for sale in the Oracle Store at:

http://shop.oracle.com/

If you have a user name and password for OTN, then you can go directly to the 
documentation section of the OTN Web site at:

http://www.oracle.com/technetwork/indexes/documentation/index.ht
ml



xi

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1About Oracle Application Express

This document offers an introduction to using Oracle Application Express applications 
from an end user’s perspective. To learn more about developing Oracle Application 
Express applications, see Oracle Database 2 Day + Application Express Developer's Guide 
and "Quick Start" in Oracle Application Express Application Builder User's Guide.

Topics:
■ About Oracle Application Express

■ About Websheet Applications

■ About Database Applications

■ About Browser Requirements

About Oracle Application Express
Oracle Application Express is a rapid Web application development tool for the Oracle 
Database. Through wizards or direct input, developers can assemble an HTML 
interface (or application) on top of database objects. Each application is a collection of 
linked pages using tabs, buttons, or hypertext links.

By creating an application, users can manage, manipulate, and display data in the 
Oracle Database. Using Oracle Application Express, developers can build two types of 
applications:

■ Websheet applications

■ Database applications

About Websheet Applications
A Websheet is an interactive Web page that enables end users to manage structured 
and unstructured data without developer assistance. Websheet applications include 
navigation controls, search capability, and the ability to add annotations such as files, 
notes, and tags. To learn more, see "Using Websheets" on page 2-1.

About Database Applications
Using only a Web browser and with limited programming experience, Oracle 
Application Express enables developers to create powerful database applications. A 
database application is an interactive user interface (UI) that enables users to quickly 
add, update, or display information stored in the Oracle Database. This information 



About Browser Requirements

1-2 Oracle Application Express End User's Guide

can be displayed in many formats, including static and interactive reports, forms, 
maps, charts, and maps. 

This guide explains how end users can customize an interactive report. With an 
interactive report, end users can customize the appearance of report data through 
searching, filtering, sorting, column selection, highlighting, and other data 
manipulations. Plus, end users can save their customizations as well as download the 
report locally. To learn more, see "Using Interactive Reports" on page 3-1.

This guide also explains how to import data into an Oracle Application Express 
application using an existing application Data Loading Wizard. To learn more, see 
"About Uploading Data" on page 4-1.

About Browser Requirements
Running an Oracle Application Express application requires a Web browser that 
supports Java Script and the HTML 4.0 and CSS 1.0 standards. The following browsers 
meet these requirements:

■ Microsoft Internet Explorer 7.0 or later version

■ Mozilla Firefox 3.6 or later version

■ Google Chrome 4.0 or later version

■ Apple Safari 4.0 or later version
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2Using Websheets

Websheet applications are interactive Web pages that combine text with data. These 
applications are highly dynamic and defined by their users. Websheet applications 
include navigation controls, search capabilities, and the ability to add annotations such 
as files, notes, and tags. Websheet applications can be secured using access control lists 
and several built-in authentication models.

Topics:
■ Running a Websheet

■ About Using Websheets

■ Managing Websheet Pages

■ About Adding and Editing Page Sections

■ About Text Sections

■ About Navigation Sections

■ About Adding Data Grids

■ About Adding and Editing Data Content

■ About Adding Data Reports

■ About Data Sections

■ About Chart Sections

■ About PL/SQL Sections           

■ Understanding Markup Syntax

■ Managing Annotations

■ Managing Websheet Applications

■ Viewing Websheets

Running a Websheet
To run a Websheet, a developer typically provides you with a URL and login 
credentials (that is, a username and password).

To run a Websheet: 

1. Click the supplied URL, or enter it in your browser’s Address field.

See Also: "About Websheet Applications" in Oracle Application 
Express Application Builder User's Guide
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A Login page appears.

2. On the Login page:

a. Username - Enter your username.

b. Password - Enter your password.

c. Click Login.

The Websheet application appears. 

About Using Websheets
This section describes interface elements common to all Websheet applications.

Topics:
■ Using Breadcrumbs and Navigation Sections

■ About the Help Link

■ About the Logout Link

■ About Websheet Search

■ About the Control Panel

Using Breadcrumbs and Navigation Sections
A breadcrumb displays at the top of every Websheet page. Positioning the mouse over 
the Home breadcrumb displays a submenu of links to all Websheet pages. To view 
another page, click the child breadcrumb entry.

See Also: "Running a Websheet" in Oracle Application Express 
Application Builder User's Guide
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About Navigation Sections
Websheets can contain multiple pages. Each navigation section includes a hierarchical 
tree that enables you to navigate between pages or page sections. 

Click the arrows on the left to expand or collapse the tree. To link to a specific section 
or page, simply click it. Click Expand All to view all pages and page subsections and 
click Reset to return the tree to the default display. To learn more, see "About 
Navigation Sections" on page 11.

Showing and Hiding Page Sections
You can hide and show page sections. To hide and show a section, click the arrow to 
the left of a section name. 



About Using Websheets

2-4 Oracle Application Express End User's Guide

About the Help Link

A Help link display in the upper right corner of each page. Clicking the Help link 
displays a small Help system that provides an overview of Websheet functionality. 
Available tabs include: About, Overview, Access Control, Markup Syntax, Access 
Control, SQL Generator for Data Grids, Application Content and FAQ. 

About the Logout Link

To log out of a running a Websheet, click the Logout link in the upper right of the 
page. The Login page appears. To return to Application Builder, click Return to 
Development.

About Websheet Search
The Search Websheet field displays in the upper right of each Websheet page.

Tip: The content in this online Help system is also covered in depth 
in "About Websheet Applications" in Oracle Application Express 
Application Builder User's Guide.
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Use Search Websheet to perform case insensitive searches of application content. 
Search results display in a report.

Once the search result display, use the Search region on the right side of the page to   
control what content to search. Searchable Content options include:

■ Page Name

■ Page Alias

■ Page Description

■ Section title

■ Section content

■ File Name, Alias, Description

■ Tags

■ Notes

■ Data Grid Data

To view content, click Search.

About the Control Panel
The Control Panel displays on the right side of most Websheet pages. To hide or 
display the Control Panel, click the arrow to the right of the region title.
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The Websheet Control Panel contains the following options:

■ New Section. See "About Adding and Editing Page Sections" on page 2-7.

■ Edit Sections. See "About Adding and Editing Page Sections" on page 2-7.

■ New Page. See "Adding a New Page" on page 2-6.

■ New Page as a Copy. See "Copying an Existing Page" on page 2-7.

■ Edit Page. See "Editing Page Details" on page 2-7.

■ Page Directory. See "Viewing the Page Directory" on page 2-39.

■ New Data Grid. See "Creating a Data Grid" on page 2-13.

Managing Websheet Pages
You can add pages to a Websheet manually, or copy existing pages.

Topics:
■ Adding a New Page

■ Copying an Existing Page

■ Editing Page Details

Adding a New Page
To add a new Websheet page:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the Create menu, select New Page.

3. On Create Page:

a. Name - Enter a page name. The page name displays as the window title as 
well as in the breadcrumb.

b. Page Alias - Identify the page alias. This alias enables you to link to this page. 
See "Linking to a Page" on page 2-28.

c. Parent Page - If this page is part of a page hierarchy, select the parent page.

d. Click Create Page.

Tip: You can also add a new page by clicking New Page and New 
Page as a Copy on the Control Panel.
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Copying an Existing Page
To copy an existing page:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the Create menu, select New Page as a Copy.

3. In New Page Name, enter the name of the new page.

4. Click Copy Page.

A success message appears.

5. Select one of the following:

■ View Current Page 

■ View New Page

Editing Page Details
On Page Details, you can change the page name, alias, parent page, or page 
description.

To edit page details:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the Edit menu, select Edit Page.

3. On the Details Page.

■ Name - Identifies the name of the page. The page name displays in the 
window title as well as in the breadcrumb.

■ Alias - A page alias enables you to create links in page sections to other pages. 
A page alias must be unique within an application. See "Linking to a Page" on 
page 2-28.

■ Owner - Identifies the owner of the page.

■ Parent Page - Identifies the parent page. The defined parent page is used to 
construct breadcrumbs and navigation between pages.

■ Page Description - Descriptive text that describes the page.

4. Click Apply Changes.

A success message appears.

About Adding and Editing Page Sections
This section describes how to add and edit page sections.

Topics:
■ About Section Types

■ About Editing Sections

Tip: If a newly copied page needs to have a different parent page, 
you can change the parent page by editing the Page Details. See 
"Editing Page Details" on page 2-7.

Tip: You can also edit page details by clicking Edit Page on the 
Control Panel. 
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■ Deleting Page Sections

■ Editing Section Titles and Display Order

About Section Types
Websheets are organized into pages which consist of containers called sections. To 
each Websheet page, you can add the following section types: 

■ Text - Display entered text, inline images, and inline reports, and links to reports, 
data grids, other pages, files, external URLs, and so on. You can create and modify 
text sections using an intuitive WYSIWIG editor. See "About Text Sections" on 
page 9.

■ Navigation - Add dynamically generated navigation to subordinate pages or page 
sections. See "About Navigation Sections" on page 11.

■ Data - Create inline reports based upon a data grid or report. See "About Data 
Sections" on page 25 and "About Adding Data Reports" on page 23.

■  Chart - Create inline charts based upon a data grid or report. See "About Chart 
Sections" on page 26.

■ PL/SQL - Select a data grid to generate SQL and SQLVALUE queries to use within 
your application. See "About PL/SQL Sections" on page 27.

About Editing Sections
To edit a page section:

1. Run the Websheet as described in "Running a Websheet" on page 1.

2. Click the Edit icon that displays in the upper right of each section.

The Edit Section page appears. 

3. Edit the section and click Apply Changes.

Deleting Page Sections
To delete a page section:

Tip: The left side of the Edit Section page lists all sections on the 
current page. The current section is highlighted. To go to another 
section, simply select it.
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1. Run the Websheet as described in "Running a Websheet" on page 1.

2. Click the Edit icon that displays in the upper right of the section.

The Edit Section page appears. 

3. Click Delete.

Editing Section Titles and Display Order
You can change the section title or display order on the Edit Sections page.

To edit all sections:

1. Run the Websheet application. See "Running a Websheet" on page 1.

2. From the Edit menu, select Edit Sections. 

The Edit Sections page appears.

3. To edit the section title, enter a new title.

4. To change the section order, click the Up and Down arrows adjacent to the section 
title.

5. Click Apply Changes.

About Text Sections
To add text to a Websheet page, you create a Text section. You can type directly into a 
Text section, or copy and paste content from a spreadsheet. Copying and pasting from 
a spreadsheet creates a new section for each spreadsheet row.

Topics:
■ Adding a Text Section

■ Editing a Text Section

Adding a Text Section
To add a text section:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

Tip: You can also edit sections by clicking Edit Sections on the 
Control Panel.

See Also: "Deleting Page Sections" on page 2-8 and "Understanding 
Markup Syntax" on page 2-28
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2. From the Create menu, select New Section.

3. When prompted for the section type, select Text and click Next.

4. On Create Text Sections select either:

■ Create single text section

■ Create multiple text section from Spreadsheet

5. If you select Create single text section:

a. Sequence - Enter the section display sequence.

b. Title - Enter a section title.

c. Content - Enter text. To learn more about formatting text, see "Editing a Text 
Section" on page 2-10.

d. Click Create Section.

6. If you select Create multiple text section from Spreadsheet:

a. First Row Contains Column Headings - Select this option if applicable.

b. Paste Spreadsheet Data - Paste a two column spreadsheet or other tab 
delimited data. The first column must contain the section title and the second 
column must contain the section content.

c. Click Create Section.

Editing a Text Section
You can edit and format text sections using an intuitive WYSIWIG editor. 

To edit a text section:

1. Run the Websheet as described in "Running a Websheet" on page 1.

2. Click the Edit icon that displays in the upper right of the section.

The Edit Section page appears. 

3. Edit the text in the field provided.

Tip: You can also add a new section by selecting New Section on the 
Control Panel.

Tip: To learn more about adding or embedding links, see 
"Understanding Markup Syntax" on page 2-28.
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4. To change the formatting, click the Expand Toolbar icon in the upper right corner.

The Toolbar appears. When you pass your cursor over an icon, a descriptive 
tooltip displays.

5. To hide the toolbar, click the Collapse Toolbar icon.

6. To save your changes, click Apply Changes.

About Navigation Sections
By creating a Navigation section, you can add dynamically generated navigation to 
subordinate pages or page sections.

Adding a Navigation Section
Once you create your Websheet pages, you can create dynamically generated 
navigation to subordinate pages or page sections.

To add a navigation section:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

See Also: "About Navigation Sections" on page 2-3, "Deleting Page 
Sections" on page 2-8, and "Editing Section Titles and Display Order" 
on page 2-9



About Adding Data Grids

2-12 Oracle Application Express End User's Guide

2. From the Create menu, select New Section.

3. When prompted for the section type, select Navigation and click Next.

4. For Navigation Type:

a. Select either:

– Page Navigation - Creates navigation of all pages in the Websheet.

– Section Navigation - Creates navigation for all section on a page.

b. Click Next.

5. If you select Page Navigation:

a. Sequence - Enter the section display sequence.

b. Title - Enter a section title.

c. Starting Page - Select the starting page from which to display hierarchical 
navigation. 

d. Maximum Levels - Select the maximum number of levels (or tree depth) to 
display.

e. Order Siblings - Select the order of siblings by column. If not defined, the 
siblings are sorted by the page name.

f. Click Create Section.

6. If you select Section Navigation:

a. Sequence - Enter the section display sequence.

b. Title - Enter a section title.

c. Click Create Section.

About Adding Data Grids
Data grids are sets of data displayed in rows and columns. Data grids store data in a 
similar way to how spreadsheets store data. Once created, the structure can be 
modified as needed over time.

Topics:
■ About Data Grids

■ Creating a Data Grid

■ Copying a Data Grid

■ Viewing and Editing a Data Grid

■ Viewing the Data Grid Change History Log

■ Deleting a Data Grid

About Data Grids
You can define the structure of a data grid using column names, data sources, and 
basic validations, or you can create a data grid by pasting spreadsheet data. Once 
created, the structure can be modified as needed.

See Also: "About Adding and Editing Data Content" on page 2-22 
and "Understanding Markup Syntax" on page 2-28
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Users can alter the layout of report data by selecting columns or by applying filters, 
highlighting, and sorting. Users can also define breaks, aggregations, group bys, 
computations, and different charts. Additionally, users can create multiple variations 
of a data grid and save them as named reports, for either public or private viewing. In 
addition to being available under the View menu, data within a data grid can be 
included as a chart or report within any page.

Creating a Data Grid
You can create a data grid by either defining the structure (that is, the column names, 
data sources, and basic validations), or by pasting in spreadsheet data. In addition to 
the defined columns, the following standard columns are always included within each 
data grid: owner, created by, created on, updated by, updated on, row order, and 
annotation (files, notes, links, and tags).

Topics:
■ Creating a Data Grid from Scratch

■ Creating a Data Grid by Copying and Pasting Spreadsheet Data

Creating a Data Grid from Scratch
When you create a data grid from scratch you must define the column names, data 
types, and basic values. Once you have created the basic structure, you can then 
populate it with data.

To create a data grid from scratch:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the Create menu, select New Data Grid.

3. When prompted for the section type, select From Scratch and click Next.

See Also: "About Chart Sections" on page 26

Tip: You can also select New Data Grid on the Control Panel.
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4. Specify the following:

a. Name - Enter a data grid name.

b. Alias - Enter a data grid alias. Use this alias to link to this data grid within 
other page sections. A data grid alias must be unique within an application.

c. Define the data grid structure by specifying the column name and data type. 
To change the order, click the Up and Down arrow under Move.

To add more columns, click Add Column.

d. Click Create Data Grid.

The Data Grid appears.

5. To add data, click Add Row. See "Editing Data Grid Data" on page 2-17.

Creating a Data Grid by Copying and Pasting Spreadsheet Data
To create a data grid by copying an pasting spreadsheet data:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the Create menu, select New Data Grid.

3. When prompted for the section type, select Copy and Paste and click Next.

4. Specify the following:

a. Name - Enter a data grid name.

b. Alias - Enter a data grid alias. You can use this alias to link to this data grid 
within page sections. A data grid alias must be unique within an application.

c. First Row Contains Column Headings - Select this option if applicable.

Tip: You can also select New Data Grid on the Control Panel.
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d. Paste Spreadsheet Data - Copy and paste the data you want to load from a 
spreadsheet program.

e. Click Upload.

A data grid appears.

5. To add data, click Add Row. See "Editing Data Grid Data" on page 2-17.

Copying a Data Grid
To copy a data grid:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the View menu, select Data Grids.

The Data page appears. 

3. Select the data grid you want to edit.

The data grid appears.

4. From the Manage menu, select Copy.

5. Enter a new data grid name and click Copy.

Viewing and Editing a Data Grid
Once you create a data grid, you can view and edit it on the Data page.

Topics:
■ Accessing the Data Page

■ Editing Data Grid Data

■ Editing Data Grid Columns Manually

■ Editing Data Grid Rows Manually

■ Editing a Single Data Grid Row

■ Editing Data Grid Properties

Accessing the Data Page
To access the Data page:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the View menu, select Data Grids.

An interactive report appears displaying all data grids. 

3. Click the View Report icon.

Tip: Data grids display as an interactive report. To learn more about 
interactive reports and using the Actions menu, see "Using Interactive 
Reports" on page 3-1 and "Using the Actions Menu" on page 3-4.
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The Report view appears.

By default, Report view displays the data grid Name, Alias, Status, Created, and 
Created By columns. The Embed Tag column displays the syntax used to include a 
link to the report or data grid from within a section of a page.

4. To view a data grid, select the data grid name.

The data grid appears. 

Toggling Check Boxes  When viewing a data grid, you can enable and disable check 
boxes. From the Manage menu, select Toggle Check Boxes. By selecting this option, 
check boxes display to the left of each row.

Note: If a Data Grid report includes files, notes, or links, those 
columns are excluded when you download the report using the 
Actions menu.



About Adding Data Grids

Using Websheets 2-17

Editing Data Grid Data
To edit data grid data:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the View menu, select Data Grids.

The Data page appears. 

3. Select the data grid you want to edit.

The data grid appears.

4. To add another row:

a. Click the Add Row button. 

A form appears.

b. Edit the fields provided and click either Save or Save and Add Another.

Editing Data Grid Columns Manually
You can manually edit the columns structure of a data grid by selecting Columns and 
on the Manage menu.

To manually edit data grid columns:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the View menu, select Data Grids.

The Data page appears. 

3. Select the data grid you want to edit.

The data grid appears.

4. From the Manage Menu, select Columns. 
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The following options display:

■ Add - Adds a new column. Enables you to define all column properties such 
as the column name, type, whether a value is required, list of values, default 
type, and default text.

■ Column Properties - Editable properties include sequence, group, required 
value, label, format, heading, width and height, column type, default text, list 
of values, and help text.

■ List of Values - Enables you to restrict the values a user can enter. You 
associate a list of values with a column on Column Properties.

■ Column Groups - Create a group and add columns to the group. Add / Edit 
row page displays groups as a subsection under the Data region and lists 
columns within the group. By using groups, you can control the Add / Edit 
row page display. 

■ Validation - Create a column validation and error message.

■ Delete Columns - Select columns to be deleted.

Editing Data Grid Rows Manually
You can manually edit the rows of a data grid by selecting Rows and on the Manage 
menu.

To manually edit data grid rows:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the View menu, select Data Grids.

The Data page appears. 

3. Select the data grid you want to edit.

The data grid appears.

4. From the Manage Menu, select Rows. 
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The following options display:

■ Add row - Adds a new row.

■ Set Column Values - Set a predefined value for a column.

■ Replace - Search and replace row values.

■ Fill - Fill NULL column values with a column value from the above cell.

■ Delete Rows - Select rows to be deleted.

Editing a Single Data Grid Row
To manually edit a single data grid row:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the View menu, select Data Grids.

The Data page appears. 

3. Select the data grid you want to edit.

The data grid appears.

4. Locate the row to be edited and click the Edit Row icon.

The Add/Edit Row page appears.

5. Edit the appropriate rows and click Apply Changes.
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Adding Annotations to a Single Data Grid Row  To add annotations (that is, files, notes, links, 
and tags) to a single data grid row:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the View menu, select Data Grids.

The Data page appears. 

3. Select the data grid you want to edit.

The data grid appears.

4. Locate the row to be edited and click the Edit Row icon.

The Add/Edit Row page appears.

5. On the Actions region, select one of the following:

■ Add File

■ Add Note

■ Add Link

■ Add Tags

6. Follow the on-screen instructions.

Displaying Annotation Columns in a Data Grid Report  To display annotation columns in a 
data grid report:

1. Add annotations to the data grid report as described in "Adding Annotations to a 
Single Data Grid Row" on page 2-20.

2. To include the columns in the data grid report:

a. View the data grid report.

b. Click the Actions menu and then Select Columns.

c. In the Select Columns region, move the columns (for example, Files, Notes, 
Links, and Tags) to Display in Report.

d. Click Apply.

Tip: You can use the Actions region on the Add/Edit Row page to 
add a new row, add annotations, view a history of changes, edit 
column properties and group, delete columns, and create a lists of 
values or a validation.

See Also: "Managing Annotations" on page 2-32
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3. To ensure all users can see the columns, developers can save the revised layout as 
the default report:

a. Click the Actions menu and select Save Report. 

The Save Report Region appears.

b. In Save Report:

a. Save - Select As Default Report Settings.

b. Name - Enter a name for the report.

c. Description - Enter an optional description.

d. Click Apply.

Editing Data Grid Properties
You can change the name, alias, and description of a data grid on the Data Grid 
Properties page.

To edit data grid properties:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the View menu, select Data Grids.

The Data page appears. 

3. Select the data grid you want to edit.

The data grid appears.

4. From the Manage menu, click Properties. 

The Data Grid Properties page appears.

5. Edit the fields provided and click Apply.

Viewing the Data Grid Change History Log
The View Change History log displays a report of data grid changes. This report lists 
the row, column name, old value, new value, user who authored the change, and how 
long ago the change occurred.

To view a history of data grid changes:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the View menu, select Data Grids.

The Data page appears. 

3. Select a data grid

The data grid appears.

4. From the Manage menu, select History.

Deleting a Data Grid
To delete a data grid:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the View menu, select Data Grids.

The Data page appears. 
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3. Select the data grid you want to edit.

The data grid appears.

4. From the Manage menu, select Delete Data Grid.

5. Confirm your selection and click Delete.

About Adding and Editing Data Content
This section describes how to add and edit data content.

Topics:
■ About Available Data Sources

■ About Enabling Support for Creating Data Reports

■ About Incorporating Data into Websheet Pages

About Available Data Sources
Websheets can include data sources. Once defined, you can incorporate these data 
sources into Websheet page sections. Websheets can include the following data 
sources:

■ Data Grids - Data grids are highly customizable, editable tabular reports. Data 
grids enable you to maintain data within the Websheet that is stored within the 
Oracle Database. See "About Adding Data Grids" on page 2-12.

■ Reports - Reports are queries defined against tables or views that already exist 
within your Oracle Database. See "About Adding Data Reports" on page 2-23.

About Enabling Support for Creating Data Reports
To define a data report, your Websheet developer must enable the Allow SQL and 
PL/SQL attribute on the Application Properties page. By default, this attribute is 
disabled. 

About Incorporating Data into Websheet Pages
Data grids and data reports can be incorporated into page sections in the following 
ways:

■ Within a data section. See "About Adding Data Reports" on page 23.

■ Within a chart section. See "Adding a Chart Section" on page 2-26.

■ Linking to a Data Grid. See "Linking to a Data Grid" on page 2-30.

■ Include a single value or tabular results of queries See "Using SQL and SQLVALUE 
Syntax" on page 2-30.

Tip: When you delete a Data Grid, chart, or report on a page, 
referencing the Data Grid will not work.

Tip: Only a Websheet application developer can edit the Allow SQL 
and PL/SQL attribute on the Application Properties page. To learn 
more, see "Editing Websheet Application Properties" in Oracle 
Application Express Application Builder User's Guide.
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About Adding Data Reports
Data reports are contributor defined queries on tables or views within the underlying 
Oracle Database.

Topics:
■ About Data Reports

■ Creating a Data Report

■ Viewing and Modifying a Data Report

■ Deleting a Data Report

■ Managing Uploaded Files and Images

About Data Reports
Data reports, unlike data grids, are query-only and based on existing data from the 
Oracle Database. You can specify the table or view name and retrieve all columns or 
write a SQL statement to retrieve the required data. 

Users can alter the layout of report data by selecting columns or by applying filters, 
highlighting, and sorting. Users can also define breaks, aggregations, group by, 
computations, and different charts. Additionally, users can create multiple variations 
of a data grid and save them as named reports, for either public or private viewing. In 
addition to being available under the View menu, data within a data report can be 
included as a chart or report within any page.

Creating a Data Report
You can create a data report by either simply entering the table or view name, or by 
providing a SQL query.

To create a data report:

1. Run the Websheet as described in "Running a Websheet" on page 1.

2. From the Create menu, select New Report.

The Edit Section page appears.

3. For Report Source, identify how to develop your source. Select one of the 
following:

a. Table - Select Table and enter the following:

– Table or View Name - Select the table name the report is to be based on.

Tip: Before you can add a data report, your Websheet application 
developer must enable the Allow SQL and PL/SQL attribute on the 
Websheet properties page. By default, this attribute is disabled. To 
learn more, see "Editing Websheet Application Properties" in Oracle 
Application Express Application Builder User's Guide.

See Also: "About Adding and Editing Data Content" on page 2-22 
and "Understanding Markup Syntax" on page 2-28

See Also: "About Data Sections" on page 2-25 and "About Chart 
Sections" on page 2-26

Tip: You can also select New Report on the Control Panel.
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– Report Name - Enter the name of the report.

– Report Alias - Enter a report alias. A Report alias is used for linking to the 
Report within page sections. A Report alias must be unique within an 
application.

b. SQL Query - Select SQL Query and enter the following:

– Report Name - Enter the name of the report.

– Report Alias - Enter a report alias. A Report alias is used for linking to the 
Report within page sections. A Report alias must be unique within a 
Websheet.

– Query - Enter the SQL query that defines your report.

c. Click Next.

4. Confirm your selections and click Create Report.

Viewing and Modifying a Data Report
To view or modify a data report:

1. Run the Websheet as described in "Running a Websheet" on page 1.

2. From the View menu, select Reports.

The Report page appears.

3. Select the report. 

The report appears.

4. To edit report attributes:

■ From the Manage menu, click Edit Attributes. 

The Report Attributes page appears.

■ Edit the attributes and click Apply Changes.

5. To edit report attributes:

■ From the Manage menu, click Edit Query. 

The Report Query page appears.

■ To save your changes, click Apply Changes.

Deleting a Data Report
To delete a data report:

1. Run the Websheet as described in "Running a Websheet" on page 1.

2. From the View menu, select Reports.

The Report page appears.

3. Select the report. 

The report appears.

4. From the Manage menu, click Edit Attributes. 

The Report Attributes page appears.

5. Click Delete.
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About Data Sections
You can create data sections based upon a data grid or report.

Topics:
■ Adding a Data Section to a Page

■ Editing a Data Section

Adding a Data Section to a Page
Once you create a data grid or report, you add it to a page by adding a data section.

To add a data section:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the Create menu, select New Section.

3. When prompted for the section type, select Data and click Next.

4. Specify the following:

a. Data Selection Source - Select either Data Grid or Report.

b. Display Sequence - Enter the section display sequence.

c. Data Grid - Select the data grid to be used to display the data section.

d. Report Settings to Use - For the selected data grid or report, select the report 
settings to use. Use this option to filter the rows and columns you want to 
display as well as set the columns to display. If you do not have a saved report 
with the settings you need, create it now before adding the section.

e. Title - Enter the section title.

f. Style - Choose a user interface style. 

g. Click Next.

5. Click Create Section.

Editing a Data Section
Once you have added a data report to a page, you can change the section sequence, 
title, and user interface style.

To edit a data section:

1. Run the Websheet as described in "Running a Websheet" on page 1.

2. Click the Edit icon that displays in the upper right of the section.

The Edit Section page appears.

3. Edit the fields provided. See item Help for more details.

4. To save your changes, click Apply Changes.

See Also: "About Adding and Editing Data Content" on page 2-22 

See Also: "About Adding Data Grids" on page 2-12 and "About 
Adding Data Reports" on page 2-23
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About Chart Sections
You can create inline charts based upon a data grid or report.

Topics:
■ Adding a Chart Section

■ Editing a Chart Section

Adding a Chart Section
To add a chart section:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. Create a data grid or report. See "About Adding Data Grids" on page 12 and 
"About Adding Data Reports" on page 23.

3. From the Create menu, select New Section.

4. When prompted for the section type, select Chart and click Next.

5. On Select Chart Type:

a. Select one of the following:

– Column

– Horizontal Bar

– Pie

– Line

b. Click Next.

6. Specify the following:

a. Display Sequence - Enter the section display sequence.

b. Data Grid - Select a data grid.

c. Report Settings to Use - For the selected data grid or report, select the report 
settings to use. Use this option to filter the rows and columns you want to 
display. 

If you do not have a saved report with the settings you need, create it now 
before adding the section.

d. Section Title - Enter the section title. 

e. Click Next.

7. Specify the following:

a. Chart Label - Select the column to be used as the Label.

In Axis Title for Label, enter the title to display on the axis associated with the 
column selected for Label.

b. Chart Value - Select the column to be used as the Value. If your function is a 
COUNT, a Value does not need to be selected.

In Axis Title for Value, enter the title to display on the axis associated with the 
column selected for Value.

See Also: "About Adding and Editing Data Content" on page 2-22 
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c. Function - Select a function to be performed on the column selected for Value.

d. Sort - Select the chart sort direction.

Check Enable 3D to display the chart in 3D.

e. Click Next.

8. On the summary page, confirm your selections and click Create Section.

Editing a Chart Section
To edit a chart section:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. Click the Edit icon that displays in the upper right of the section.

The Edit Section page appears.

3. Edit the fields provided. See item Help for more details.

4. Click Apply Changes.

About PL/SQL Sections
Users with PL/SQL knowledge can use PL/SQL sections to write their own code 
against the associated schema. 

Topics:
■ Adding a PL/SQL Section

■ Editing a PL/SQL Section

Adding a PL/SQL Section
To add a PL/SQL section:

1. Run the Websheet application. See "Running a Websheet" on page 2-1.

2. From the Create menu, select New Section.

3. When prompted for the section type, select PL/SQL and click Next.

4. Specify the following:

a. Sequence - Enter the section display sequence.

b. Title - Enter the section title.

c. Enter PLSQL - Enter a PL/SQL anonymous block of code.

Tip: PL/SQL sections are only available if the Websheet application 
developer has enabled the Allow SQL and PL/SQL attribute on the 
Application Properties page. To learn more, see "Editing Websheet 
Application Properties" in Oracle Application Express Application Builder 
User's Guide.

See Also: "Deleting Page Sections" on page 2-8 

Tip: You can also select New Section on the Control Panel. See 
"About the Control Panel" on page 2-5.
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d. If applicable, select Do not validate PL/SQL code (parse PL/SQL code at 
runtime only). Select this option to create the section even if an errors occurs. 
Use this option to create the section and then debug it later.

5. Click Create Section.

Editing a PL/SQL Section
To edit a PL/SQL section:

1. Run the Websheet as described in "Running a Websheet" on page 1.

2. Click the Edit icon that displays in the upper right of the section.

The Edit Section page appears.

3. Edit the following:

a. Sequence - Enter the section display sequence.

b. Title - Enter the section title.

c. Enter PL/SQL - Enter a PL/SQL anonymous block of code. 

4. To save your changes, click Apply Changes.

Understanding Markup Syntax
This section describes syntax for adding links to Websheet pages, page sections, 
external URLs, data grids, or for including SQL or SQLVALUE syntax.

Topics:
■ Linking to a Page

■ Linking to a Section

■ Linking to External URLs

■ Linking to a Data Grid

■ Using SQL and SQLVALUE Syntax

■ About Advanced Data Grid Queries Rules

Linking to a Page
To include links in page sections to other pages in a Websheet, use the syntax 
described below. If the page exists, a link displays. If the page does not exist, a link to 
create the page displays. Note that the use of the page: identifier is optional. 

Syntax:
[[ page: <page alias> | <link name> ]]
[[ <page alias> | <link name> ]]

Tip: To view an example, click PL/SQL Example.

Tip: Clicking Help from within a Websheet displays the Markup 
Syntax page which lists all the different syntax options described in 
this section.

See Also: "Managing Uploaded Files and Images" on page 32
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Syntax Example:
[[page: home]] 
[[mypage | My Page]]

In Context Example:
One of the most colorful fish is the [[ clownfish | Clown fish]].

Linking to a Section
To include links to a page section, use the syntax below. If the section exists, a link 
displays. If the section does not exist, a link to create the section displays. Note that if 
the section is not prefaced by a page, it is assumed the section is on the current page.

Syntax:
[[ section: <page alias> . <page section> | <link name> ]]
[[ section: <page section> | <link name> ]]

Syntax Example Linking Within the Current Page:
[[section: clownfish | Clown Fish]] 

Syntax Example Linking to a Different Page:
[[section: fish.clownfish | Clown Fish]] 

In Context Example:
One of the most colorful fish is the [[ section: clownfish | Clown fish]].
Visit or fish page to see the [[ section: fish . clownfish | Clown fish]], also 
known as Nemo.

Linking to External URLs
To include links to external URLs in page sections, use the syntax below. Note that the 
use of the url: identifier is optional. To have the link open in a new browser window, 
use the popup prefix.

Syntax:
[[ url: <url> | <link name> ]]
[ popupurl: <url> | <link name> ]]
[[ <url> | <link name> ]]

Syntax Example:
[[url: http://www.company.com/store | commpanystore]]
[[popupurl: http://www.company.com/store | commpanystore]]
[[http://www.searchengine.com | searchengine]] 
[[http://www.searchengine.com ]] 

In Context Example:
You can buy Company software on the [[http://www.company.com/store | Company 
Store]] web site.
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Linking to a Data Grid
To include links to data grids within page sections, use the syntax below. You can use 
these links to view the data grid or to create new data. Note that data grid can be one 
or two words.

Syntax:
[[ data grid: <datagrid alias | <link name> ]]
[[ datagrid: <datagrid alias | <link name> ]]
[[ datagrid: <datagrid alias . <saved report name (may not be private)> | <link 
name> ]] 

Syntax Example:
[[ data grid: todo list | To Do List ]]
[[ data grid: todo list . open todo items | To Do List ]]
[[ datagrid: todo list | To Do List ]] 

In Context Example:
Please review the [[ data grid: todo list | To Do List ]] and ensure 
your tasks can be accomplished by Friday.

Using SQL and SQLVALUE Syntax
Using SQL or SQLVALUE syntax, you can include single value and tabular results of 
queries against data grids or tables and views within sections of a page. The SQLVALUE 
tag displays the first column of the first row returned by the SQL query. Use this 
syntax to embed data within a sentence (for example: There are currently 5 types of 
cats.). For tabular results, use the SQL tag. Using SQL tag produces a searchable report. 
However, you can disable the search option by using the NOSEARCH syntax.

When working with data grids, there are a few more options (shown under Syntax) 
and a few more rules. Basic rules when writing a data grid query include:

■ The data grid name or data grid alias must be enclosed with curly brackets. For 
example:

{Cat Facts}

■ The Data Grid column names must be enclosed with double quotes. For example:

"Type of Cat"

To learn more about advanced rules, see "About Advanced Data Grid Queries Rules" 
on page 31.

Syntax for Queries Against Tables and Views:
[[sql: <select statement> ]]
[[sql: <select statement | limit="<maximum rows>" nosearch style="<style number>" 
]]
[[sqlvalue: <select statement> ]]

Syntax for Data Grid Queries:
[[sql: <select statement> ]]
[[sql: <select statement | limit="<maximum rows>" nosearch style="<style number>" 
edit_row add_row show_sql ]]
[[sqlvalue: <select statement> ]]
[[sqlvalue: <select statement> | show_sql ]]
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In Context SQL Tag Syntax Examples:
Here is a report of at most 10 employees who work in department 10:

[[sql: select ename "Employee Name", sal "Salary" from emp order by sal desc | 
limit="10" style="2"]].
[[sql: select "Type of Cat",
              "Estimated Population",
              "Largest Threats",
              "Top Speed",
              "Scientific Name",
              "IUCN Status",
              "Weight",
              "Study Date"
       from {Cat Facts} | add_row edit_row ]]

In Context SQLVALUE Tag Syntax Examples:
We have [[sqlvalue: select count(*) from emp]] employees in our database, 
[[sqlvalue: select count(*) from emp where deptno=10 ]] work in department 10.
We are currently tracking [[sqlvalue: select count(*) from {Cat Facts} ]] types of 
cats.

About Advanced Data Grid Queries Rules
Advanced data grid query rules include:

■ In order to include an edit or add a row link, the query must only reference the 
data grid once. In other words, you cannot join the data grid to itself within the 
query.

■ The first column must be the primary key of the data grid to include an edit row 
link (that is, the column that uniquely identifies the row of data). If the "edit_row" 
option is included and the query has a single select statement, the primary key 
column is included automatically. If the query contains multiple SELECT 
statements, you can use the "APXWS_DATA_GRID_PK" substitution (always enclosed 
with double quotes) as the first column in the SELECT statement to include the 
primary key in order to include an edit row link.

■ Report column names will be the column name from the data grid, but can be 
modified using standard SQL column aliasing syntax. For example, the following 
displays the data from the Minimum Number column but the heading will display as 
Min:

select "Minimum Number" "Min" from ...

■ If a column name is longer than 30 characters, you only include the first 30 
characters as the name. For example, use:

"% of Estimated Lions per Regio"

Instead of:

"% of Estimated Lions per Region"

■ To display the query that is executed, include the "show_sql" option. The causes 
the query to display above the included report. Although this is a good approach 
for debugging, Oracle does not recommend "show_sql" for a production 
application.
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Managing Annotations
You can add commentary and additional details to a Web page by adding annotations. 
Annotations can be in the form of uploaded files, notes, links, and tags. Annotations 
can be added to both pages and data grid records.

Topics:
■ Managing Uploaded Files and Images

■ Adding Tags

■ Adding Notes

■ Viewing and Deleting Annotations

Managing Uploaded Files and Images
You can upload files and images to a Websheet page using the Files region. Once 
uploaded, you can display uploaded images within a page section or embed 
download links to files. 

Topics:
■ Uploading Files and Images

■ Including a Download Link in a Page Section

■ Displaying an Uploaded Image Inline

■ Editing or Deleting Uploaded Files

Uploading Files and Images
To upload files and images to a Websheet:

1. Log in to and run the Websheet. See "Running a Websheet" on page 1.

2. Under Files on the right side of the page, click the Add File icon.

3. On the Add File page:

a. File - Browse to locate the file to be uploaded. Once uploaded, the file is 
associated a file with the current page. You can reference an uploaded file in 
any page using the image or file syntax. See "Displaying an Uploaded Image 
Inline" on page 33 or online Help, Markup Syntax.

b. Alias - A file alias enables you to embed download links or image links within 
page sections. A file alias must be unique within an application. 

c. Description - Enter descriptive text to describe the file.

4. Click Add File.

See Also: "Adding Annotations to a Single Data Grid Row" on 
page 2-20
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Including a Download Link in a Page Section
You can embed a download link within a page section to uploaded files using the 
following syntax.

Syntax:
[[ file: < file name > | < link name > ]]
[[ file: < file alias > | < link name > ]]

Syntax Examples:
[[file: myfile ]]
[[file: myfile.xls ]]
[[file: myfile | My File ]]

File Markup Example:
This [[file: parts01.xls | spreadsheet ]] documents our part numbers.

Displaying an Uploaded Image Inline
After you upload an image, you can display it within any page section of an 
application by embedding a download link using the following syntax. You can 
reference an uploaded image using the image name or image alias. 

Images defined for the current page are used before images associated with other 
pages. If image names are ambiguous, the most recently created image displays. 

Syntax:
[[ image: < file name > | < properties > ]]
[[ image: < file alias > | < properties > ]]

Syntax Examples:
[[image: myimage ]]
[[image: theimagename.jpg ]]
[[image: myimage | width="600" alt="my image" ]]

Example:
This diagram [[image: diagram1]] illustrates the work flow.

Editing or Deleting Uploaded Files
To edit details or delete uploaded files:

1. Log in to and run the Websheet. See "Running a Websheet" on page 1.

2. In the Files region, click the Edit File icon.

The Details page appears.

3. To edit file details:

a. Edit the fields provided. See item Help for more details.

b. To accept your changes, click Apply Changes.
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4. To delete a file:

a. Click Delete.

b. To accept your changes, click OK.

Adding Tags
Tags facilitate keyword searching within a Websheet.

Topics:
■ Adding Tags

■ Editing Existing Tags

Adding Tags
To add tags to a Websheet page:

1. Log in to and run the Websheet. See "Running a Websheet" on page 1.

2. Under Tags on the right side of the page, click the Add Tag icon.

3. Enter tags in the field provided. Separate multiple tags with a comma.

4. Click Add Tags.

Editing Existing Tags
To edit existing tags:

1. Log in to and run the Websheet. See "Running a Websheet" on page 1.

2. In the Tags region, click the Edit Tag icon.

The Details page appears.

3. Edit the tags and click Add Tags.

Adding Notes
Notes record user comments.

Topics:
■ Adding Notes

■ Editing or Deleting Existing Notes

Adding Notes
To add notes to a Websheet page:

1. Log in to and run the Websheet. See "Running a Websheet" on page 2-1.

2. Under Notes on the right side of the page, click the Add Note icon.
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3. Enter text in the field provided.

4. Click Add Note.

Editing or Deleting Existing Notes
To edit or delete existing notes:

1. Log in to and run the Websheet. See "Running a Websheet" on page 2-1.

2. In the Notes region, click the Edit Note icon.

3. To edit file details:

a. Edit the fields provided. See item Help for more details.

b. To accept your changes, click Apply Changes.

4. To delete a note, click Delete.

Viewing and Deleting Annotations
You can view and delete all Websheet annotations on the Annotations page. 
Annotations include uploaded files, notes, links, and tags that were either added to a 
Websheet page or to a specific row in a data grid.

Topics:
■ Accessing the Annotations Page

■ Deleting Annotations

Accessing the Annotations Page
To access the Annotations page:

1. Log in to and run the Websheet. See "Running a Websheet" on page 2-1.

2. From the View menu, select Annotations.

The Annotations page appears.
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The Annotations page displays as an interactive report. To learn more about 
interactive reports, see "Using Interactive Reports" on page 3-1 and "Using the 
Actions Menu" on page 3-4.

3. To view specific type of annotation, click the Files, Notes, Links, Tags, or Tag 
Cloud tabs.

Deleting Annotations
To delete uploaded files, notes, link, or tags:

1. Log in to and run the Websheet. See "Running a Websheet" on page 2-1.

2. From the View menu, select Annotations.

The Annotations page appears.

3. Select an annotation type by clicking the appropriate tab at the top of the page.

4. If not already selected, click the View Report icon.

5. Select the annotations to delete.

6. Click Delete Checked.

Managing Websheet Applications
This section describes how to change your Websheet password, email a Websheet to 
another user, and print a Websheet.

Topics:
■ Changing Your Websheet Password

■ Emailing a Websheet Page

■ Printing a Websheet Page

Changing Your Websheet Password
To change your Websheet password:

1. Log in to and run the Websheet. See "Running a Websheet" on page 2-1.

2. From the Administration menu, select Change My Password.

The Change Password page appears.
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3. Follow the on-screen instructions and click Change Password.

Emailing a Websheet Page
To email a Websheet page:

1. Log in to and run the Websheet. See "Running a Websheet" on page 2-1.

2. Locate the page you want to email.

3. Click the Email Page icon above the Control Panel.

4. On the Email Page:

a. To - Enter the target email address.

b. Subject - Enter a description of this email.

c. Body - Enter the email content you want to include along with the Websheet 
page link.

5. Click Send.

An email link to the currently selected page will automatically be included in your 
email message.

Printing a Websheet Page
To print e Websheet in printer-friendly mode:

1. Log in to and run the Websheet. See "Running a Websheet" on page 2-1.

2. Click the Print icon above the Control Panel.

The page displays in printer-friendly mode.

See Also: "Configuring Email" in Oracle Application Express 
Administration Guide
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Viewing Websheets
Use the options on the View menu to access presentation mode, view a page directory, 
access a page history, and view an application directory.

Topics:
■ About Presentation Mode

■ Viewing the Page Directory

■ Viewing Page History

■ Viewing the Application Directory

About Presentation Mode
Presentation mode enables a single Websheet page to be viewed as if it were a 
presentation. Each page section displays one at a time as a slide. To view a Websheet in 
presentation mode, click the Presentation icon on the far right side of the page.

In Presentation mode, each page section displays as a separate page. 

See Also: "Managing Annotations" on page 2-32 and "About Adding 
Data Grids" on page 2-12
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Use the navigation bar on the upper right of the page to scroll forward and backward 
from section to section. To exit Presentation mode, click the Exit icon or press ESC.

Viewing the Page Directory
Use the Page Directory to view all pages in the current Websheet. Each Websheet can 
be comprised of any number of pages.   

To access the Page Directory:

1. Log in to and run the Websheet. See "Running a Websheet" on page 2-1.

2. From the View menu, select Page Directory.

The Page Directory displays as an interactive report. To learn more about 
interactive reports and using the Actions menu, see "Using Interactive Reports" on 
page 3-1 and "Using the Actions Menu" on page 3-4.

By default, the Page Directory displays in icon view.
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One page in each Websheet is designated as the Home page. The Home page is the 
starting page that displays when you run the Websheet. In Icon view, the home 
page displays as a page with orange outline of home. 

3. To view the page as a report, click the View Report icon. 

By default, Report view displays the following columns: Name, Doc Type, 
Created, Created By, Updated On, Updated By, Parent Page, and Grand Parent 
Page.

Viewing Page History
Use the Page History to view a log of all changes to the current page. 

To view the Page History:

1. Log in to and run the Websheet. See "Running a Websheet" on page 2-1.

2. Select a page. 

3. From the View menu, select Page History.

4. From the Page list, select a page and click Set.

5. To return to the default display, click Reset.

The Page History displays as an interactive report. To learn more about interactive 
reports and using the Actions menu, see "Using Interactive Reports" on page 3-1 
and "Using the Actions Menu" on page 3-4.

6. To view a page, click the page name.

Viewing the Application Directory
Use the Application Directory to navigate between Websheet applications. 

To access the Application Directory:

1. Log in to and run the Websheet. See "Running a Websheet" on page 2-1.

2. From the View menu, select Application Directory.

The Application Directory displays as an interactive report. To learn more about 
interactive reports and using the Actions menu, see "Using Interactive Reports" on 
page 3-1 and "Using the Actions Menu" on page 3-4.

3. To view an application, select it.
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3Using Interactive Reports

An Oracle Application Express database application is a collection of pages linked 
together using tabs, buttons, or hypertext links. This section describes how to use 
Oracle Application Express interactive reports.

Topics:
■ Running an Interactive Report

■ What is an Interactive Report?

■ Using the Column Heading Menu

■ Using the Search Bar

■ Using the Actions Menu

Running an Interactive Report
An interactive report is contained in a page within a database application. In order to 
run an interactive report you must log into the database application and then navigate 
to the report page. To accomplish this, you need the URL for the database application 
and the account credentials (that is, a username and password).

To run an interactive report: 

1. Click the supplied URL, or enter it in your browser’s Address field.

A Login page appears.

2. On the Login page:

a. Username - Enter your username.

b. Password - Enter your password.

c. Click Login.

The interactive report appears.

What is an Interactive Report?
Oracle Application Express includes two main report types, an interactive report and a 
classic report. The main difference between these two report types is that interactive 
reports enable the user to customize the appearance of the data through searching, 
filtering, sorting, column selection, highlighting, and other data manipulations.

See Also: "Creating Reports" in Oracle Application Express Application 
Builder User's Guide.
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About Interactive Reports
The following is an example of an interactive report.

Interactive reports enable end users to create highly customized reports. Users can 
alter the report layout by hiding or exposing specific columns and applying filters, 
highlighting, and sorting. They can also define breaks, aggregations, charts, group 
data, and add their own computations. Once customized, the report can be saved as 
either a private or public report. Most interactive reports includes a search bar, Actions 
menu, Column Heading menu, and edit icons in the first column of each row.

In contrast, classic reports support general keyword search capability, the ability to 
specify the number of rows that display, and basic column sorting. 

Using the Column Heading Menu
Clicking a column heading in an interactive report exposes the Column Heading 
menu. Positioning the cursor over each icon displays a tooltip that describes its 
function.

Column Heading menu options include:

■ Sort Ascending - Sorts the report by the column in ascending order.

■ Sort Descending - Sorts the report by the column in descending order.
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■ Hide Column - Hides the column. Not all columns can be hidden. If a column 
cannot be hidden, the Hide Column icon does not display.

■ Control Break - Creates a break group on the column. This pulls the column out of 
the report as a master record. See "Creating a Control Break" on page 3-10.

■ Column Information - Displays help text about the column, if available.

■ Text Area - Used to enter a case insensitive search criteria. Entering a value 
reduces the list of values at the bottom of the menu. You can then select a value 
from the bottom. The selected value will be created as a filter using either the 
equal sign (=) or contains depending on the List of Values Column Filter Type. 

■ List of Unique Values - Contains the first 500 unique values that meets your filter 
criteria. If the column is a date, a list of date ranges is displayed instead. 

Using the Search Bar

A search bar displays at the top of most interactive reports and may include the 
following features:

■ Select Columns icon - Resembles a magnifying glass. Click this icon to narrow 
your search to specific columns. To search all columns, select All Columns. See 
"Using the Select Columns To Search Icon" on page 3-3.

■ Text area - Enter case insensitive search criteria (wildcard characters are implied) 
and then click Go.

■ Go button - Executes a search.

■ Reports - Displays alternate default and saved private or public reports. See 
"Saving an Interactive Report" on page 3-20.

■ View icons - Switches between icon, report and detail view of the default report (if 
enabled). May also include Chart and Group By View (if defined).

■ Actions menu - Clicking the icon displays the Actions menu. Use this menu to 
customize an interactive report. See "About the Actions Menu" on page 3-5.

Using the Select Columns To Search Icon
The Select columns to search icon displays to the left of the search bar. Clicking this 
icon displays a listing of all columns in the current report. 

To search specific columns:

1. Click the Select columns to search icon and select a column.

Tip: Developers can customize what displays on the Search bar. To 
learn more, see "Customizing the Interactive Search Bar" in Oracle 
Application Express Application Builder User's Guide.
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2. Enter keywords in the Text area and click Go.

3. To disable the filter, select the Enable/Disable Filter check box.

4. To delete the filter, click the Remove Filter icon.

Using the Actions Menu
You can customize an interactive report by selecting options on the Actions menu. 

Topics:
■ About the Actions Menu

■ Selecting Columns to Display

■ Adding a Filter

■ Specifying Rows Per Page

■ Selecting Column Sort Order

■ Creating a Control Break

■ Adding Highlighting

■ Computing Columns

■ Aggregating a Column

■ Creating a Chart from the Actions Menu

■ Grouping Columns

■ Executing a Flashback Query

■ Saving an Interactive Report

■ Resetting a Report

■ Downloading a Report

See Also: "Selecting Columns to Display" on page 3-6

Tip: Not all options described in this section are available on every 
Actions menu. Developers can customize what options appear. To 
learn more, see "Customizing the Interactive Search Bar" in Oracle 
Application Express Application Builder User's Guide.



Using the Actions Menu

Using Interactive Reports 3-5

■ Subscribing to Emailed Reports

About the Actions Menu
The Actions menu appears to the right of the Go button on the Search bar. Use this 
menu to customize an interactive report. 

The Actions menu contains the following options:

■ Select Columns specifies which columns to display and in what order. See 
"Selecting Columns to Display" on page 3-6.

■ Filter focuses the report by adding or modifying the filter clause on the query. See 
"Adding a Filter" on page 3-7.

■ Rows Per Page determines how many rows display in the current report. See 
"Specifying Rows Per Page" on page 3-9.

■ Format contains the following submenu:

– Sort - Changes the columns to sort on and determines whether to sort in 
ascending or descending order. See "Selecting Column Sort Order" on 
page 3-10.

– Control Break - Creates a break group on one or several columns. This pulls 
the columns out of the interactive report and displays them as a master record. 
See "Creating a Control Break" on page 3-10.

– Highlight - Defines a filter that highlights the rows that meet the filter criteria. 
See "Adding Highlighting" on page 3-11.

– Compute - Enables users to add computed columns to a report. See 
"Computing Columns" on page 3-13.

– Aggregate - Enables users to perform mathematical computations against a 
column. See "Aggregating a Column" on page 3-14.

– Chart - Displays the report data as a chart. See "Creating a Chart from the 
Actions Menu" on page 3-15.
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– Group By - Enables users to group the result set by one or more columns and 
perform mathematical computations against columns. See "Grouping 
Columns" on page 3-17.

■ Flashback - Enables you to view the data as it existed at a previous point in time. 
See "Executing a Flashback Query" on page 3-19.

■ Save Report - Saves the interactive report. Depending upon their user credentials, 
users can save different types of reports. See "Saving an Interactive Report" on 
page 3-20.

■ Reset - Enables users to reset the report back to the default report settings. See 
"Resetting a Report" on page 3-22.

■ Help - Provides descriptions of how to customize interactive reports. 

■ Download - Enables users to download a report. Available download formats 
depend upon your installation and report definition. See "Downloading a Report" 
on page 3-22.

■ Subscription - Enables users to send themselves an interactive report by email. 
See "Subscribing to Emailed Reports" on page 3-22

Selecting Columns to Display
To customize a report to include specific columns, select Select Columns on the 
Actions menu.

To use the Select Columns option:

1. Click the Actions menu and select Select Columns.

The Select Columns region appears. 

2. Select the columns you want to move. Click the center arrows to move a column 
from the Display in Report box to the Do Not Display box. To select multiple 
columns at once, press and hold the CTRL key.

3. To change the order of the columns, click the Top, Up, Down, and Bottom arrows 
on the right.

4. Click Apply. 

A revised report appears.

See Also: "Resetting a Report" on page 3-22
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Adding a Filter
You can create a filter on an interactive report by adding or modifying the filter clause 
on the query. You can create two types of filters:

■ Column - Creates a custom column filter. Select a column (it does not need to be 
one that displays), select a standard Oracle operator, and enter an expression to 
compare against. Expressions are case sensitive. Use % as a wild card. For 
example: 

STATE_NAME like A%

■ Row - Creates a custom row filter. This filter creates a complex filter clause using 
column aliases and any Oracle functions or operators. For example:

 G = 'VA' or G = 'CT'

Where G is the alias for the CUSTOMER_STATE column and you want to filter the 
results to see Virginia and Connecticut.

Adding a Column Filter
To add a column filter:

1. Click the Actions menu and select Filter.

The Filter region appears. 

2. For Filter Type, select Column. 

3. In the Filter region, specify a column, an operator, and expression.

This examples narrows the display to Discussion Forum projects.

4. Click Apply.
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Notice the filter Project = 'Discussion Forum' has been added to the Report 
Settings area above the report.

5. To revise the filter:

a. Click the filter name (in this example, Project = 'Discussion Forum').

b. Edit your selections and click Apply.

6. To disable the filter, select the Enable/Disable Filter check box.

7. To delete the filter, click Remove Filter.

Adding a Row Filter
To add a row filter:

1. Click the Actions menu and select Filter.

The Filter region appears. 

2. For Filter Type, select Row. 

3. In the Filter region:

a. Name - Enter a name that describes this filter.

b. Filter Expression - Enter an expression. Select a column and function or 
operator at the bottom of the region.

4. Click Apply.
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The Row Filter narrows the display to projects with a cost of $5000 or more.

5. To revise the filter:

a. Click Row Filter.

b. Edit your selections and click Apply.

6. To disable the filter, select the Enable/Disable Filter check box.

7. To delete the filter, click Remove Filter.

Specifying Rows Per Page
You can specify the number of rows that display on a page by selecting Rows Per Page 
on the Actions menu.

To specify the number of rows that display:

1. Click the Actions menu and select Rows Per Page.

2. From the submenu, select a number.
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Selecting Column Sort Order
You can specify column display sort order (ascending or descending) by selecting Sort 
on the Format submenu. You can also specify how to handle NULL values. Using the 
default setting always displays NULL values last or always display them first. 

To sort by column:

1. Click the Actions menu and select Format and then Sort.

The Sort region appears.

2. Select a column, the sort direction (Ascending or Descending), and Null Sorting 
behavior (Default, Nulls Always Last, or Nulls Always First).

3. Click Apply.

Creating a Control Break
You can create a break group of one or several columns by selecting Control Break 
from the Actions, Format submenu. Creating a break group pulls the columns out of 
the interactive report and displays them as a master record.

To create a break group:

1. Click the Actions menu and select Format and then Control Break.

The Control Break region appears.

2. Select a column and then a status (Enable or Disable)
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3. Click Apply. 

A revised report displays.

Note the defined break groups display in the Report Settings area above the 
report.

4. To collapse the break group, click the plus (+) sign.

5. To disable the Control Break filter, deselect the Enable/Disable Filter check box. 
Select is again to enable the filter.

6. To delete the filter, click Remove Breaks.

Adding Highlighting
You can customize the display to highlight specific rows in a report by selecting 
Highlight on the Actions, Format submenu.

To add highlighting:

1. Click the Actions menu and select Format and then Highlight.

The Highlight region appears.
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2. Edit the following information:

a. Name - Enter a name that describes this filter.

b. Sequence - Enter a numeric value to identify the sequence in which 
highlighting rules are evaluated. 

c. Enabled - Select Yes.

d. Highlight Type - Select Cell or Row.

e. Background Color - Select a new color for the background of the highlighted 
area. 

f. Text Color - Select a new color for the text in the highlighted area. 

g. Highlight Condition - Select a column, an operator, and expression.

3. Click Apply.
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Note the highlight On-Hold Projects appears in the Report Settings area above 
the report.

4. To revise the highlight, click the highlight name and make the following edits:

a. Background Color - Select yellow.

b. Text Color - Select green.

c. Click Apply.

5. To disable the highlight, select the Enable/Disable check box.

6. To delete the highlight, click Remove Highlight.

Computing Columns
You can add computations to columns by selecting Compute from the Actions, Format 
submenu. These computations can be mathematical computations (for example, NBR_
HOURS/24) or standard Oracle functions applied to existing columns. 

To create a computation:

1. Click the Actions menu and select Format and then Compute.

The Compute region appears.

2. In the Compute region:

a. Computation - Select New Computation.

b. Column Heading - Enter the name of the new column to be created.

c. Format Mask - Select an Oracle format mask to be applied to the new column. 
(for example, $9999).

Next, create the computation. 

d. Create the computation:

– Columns - Select a column or alias.

– Keypad - Select a shortcut for commonly used keys.

– Functions - Select the appropriate function.

In the following example, a new column compares the actual cost to the 
budgeted amount, using the formula I - J, where I is the cost and J is the 
budgeted amount.



Using the Actions Menu

3-14 Oracle Application Express End User's Guide

3. Click Apply.

The revised report appears containing a new Cost Analysis column.

Deleting a Computation
To delete a computation:

1. Click the Actions menu and select Format and then Compute.

The Compute region appears.

2. From Computation, select a computation. 

The computation appears.

3. Click Delete.

Aggregating a Column 
You can define a aggregation against a column by selecting Aggregate from the 
Actions, Format menu. Aggregates are displayed after each control break and at the 
end of the report within the column for which they are defined. 

To aggregate columns:

1. Click the Actions menu and select Format and then Aggregate.

The Aggregate region appears.

2. In the Aggregate region:
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a. Aggregation - Select New Aggregation.

b. Function - Select one of the following: Sum; Average, Count, Count Distinct, 
Minimum, Maximum, or Median.

c. Column - Select a column.

This example creates a sum of the Budget column.

3. Click Apply.

The computation appears at the bottom of the report.

In this example, the aggregate shows the sum of all amounts in the Budget 
column. 

Removing an Aggregate
To remove aggregate columns:

1. Click the Actions menu and select Format and then Aggregate.

The Aggregate region appears.

2. From Aggregation, select a previously defined aggregation.

3. Click Delete.

Creating a Chart from the Actions Menu
To create a chart, select Chart on the Actions, Format menu. You can create one chart 
for each interactive report. Once defined, you can switch between the chart and report 
views using links on the Search bar. 

To create a chart:

1. Click the Actions menu and select Format and then Chart.

The Chart region appears.

2. In the Chart region, specify the appropriate options. 
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The following attributes are for bar charts:

a. Chart Type - Select the type of chart you want to create (horizontal bar, vertical 
bar, pie, or line.).

b. Label - Select the column to be used as the label. 

c. Axis for Title for Label - Enter title to be displayed on the axis associated with 
the column selected for Label (not available for pie chart).

d. Value - Select the column to be used as the Value. If your function is a COUNT, a 
Value does not need to be selected. 

e. Axis Title for Value - Enter the title to display on the axis associated with the 
column selected for Value (not available for pie chart). 

f. Function - (Optional) Select a function to be performed on the column selected 
for Value.

g. Sort - Select a sorting method.

3. Click Apply.

The chart appears.
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Note the Search bar now contains two icons: View Report and View Chart.

4. Click these icons to toggle between chart and report views.

Editing a Chart
To edit a chart:

1. While viewing a report:

a. Click the Actions menu and select Format and then Chart.

The Chart region appears.

b. Edit your selections and click Apply.

2. While view the chart:

a. Click Edit Chart.

b. Edit your selections and click Apply.

Deleting a Chart
To delete a chart:

1. While viewing a report:

a. Click the Actions menu and select Format and then Chart.

The Chart region appears.

b. Click Delete.

2. While viewing a chart:

a. Click Edit Chart.

b. Click Delete.

Grouping Columns
Group By enables users to group the result set by one or more columns and perform 
mathematical computations against the columns. Once users define the group by, they 
can switch between the group by and report views using the View Icon on the Search 
bar.

To use Group By:

1. Click the Actions menu and select Format and then Group By.

The Group By region appears.
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2. From Group by Column, select up to three columns to display.

3. To include a computation, select the function, column, label, and format mask.

4. To specify sorting, select a sort column, sort direction, and preferences for NULL 
values.

5. Click Apply.
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A Group By icon appears below the Search bar. The resulting report displays the 
Project, Task Name, and Budget columns. Additionally, a new column, Total Cost, 
displays on the right side.

Editing a Group By
To edit a group by:

1. Click Edit Group By.

The Group By region appears.

2. Edit the attributes.

3. Click Apply.

Deleting a Group By
To delete a group by:

1. Click Edit Group By.

The Group By region appears.

2. Click Delete.

Executing a Flashback Query
You can execute a flashback query by selecting Flashback from the Actions menu. A 
flashback query enables you to view the data as it existed at a previous point in time. 
The default amount of time that you can flashback is 3 hours (or 180 minutes) but the 
actual amount will differ for each database.

To execute a flashback query:

1. Click the Actions menu and select Flashback.

2. In the Flashback region, enter the number of minutes.

3. Click Apply.
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Saving an Interactive Report
As an end user, you can save a private or public interactive report. Only the user who 
creates a private report can view, save, rename, or delete it. The following shows the 
Reports list on the Search bar of an interactive report. 

This example shows two reports:

■ Default - Primary Report. This is the initial report created by the application 
developer. Default, Primary reports cannot be renamed or deleted. 

■ Private - 1. By Owner. This is a Private report. Only the user who creates a private 
report can view, save, rename, or delete it.

Topics:
■ About Configuration Dependencies

■ Saving a Public or Private Interactive Report

■ Renaming a Public or Private Interactive Report

■ Deleting a Public or Private Interactive Report

About Configuration Dependencies
The ability to save an interactive report is configurable by your application developer. 
To learn more, see "Customizing the Search Bar" and "Saving an Interactive Report" in 
Oracle Application Express Application Builder User's Guide.

Saving a Public or Private Interactive Report
End users can save an interactive report and classify it as being either:

■ Public. The report can be saved, renamed, or deleted by the end user who created 
it. Other users can view and save the layout as another report.

■ Private. Only the end user that created the report can view, save, rename or delete 
the report.

To save a public or private interactive report:

1. Go to the page containing the interactive report you want to save.

2. Customize the report (for example, hide columns, add filters, and so on). See 
"Using the Actions Menu" on page 3-4.

3. Click the Actions menu and select Save Report.

The Save Report region appears.
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4. In Save Report:

a. Name - Enter a name for the report.

b. Description - Enter an optional description.

c. Public - Select this check box to make the report viewable to all users. Deselect 
this check box to make the report private.

d. Click Apply.

Renaming a Public or Private Interactive Report
To rename a public or private interactive report:

1. Run the report as a developer.

2. Click the Rename Report link.

3. Edit the attributes (for example, enter a new name).

4. Click Apply.

Deleting a Public or Private Interactive Report
To delete a  public or private interactive report:

1. Run the report as a developer.

2. To edit the report:

a. Click the alternative report name link. 

b. Edit the attributes (for example, enter a new name).

c. Click Apply.

3. Click the Delete Report icon next to the report name link.

Tip: The ability to save an interactive report as Public is determined 
by your application developer. See "About Configuration 
Dependencies" on page 3-20.
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4. Click Apply.

Resetting a Report
You can reset a report back to the default settings by selecting Reset from the Actions 
menu. Resetting a report removes any customizations you have made.

To reset a report:

1. Click the Actions menu and select Reset.

2. Click Apply.

Downloading a Report
You can download an interactive report back by selecting Download from the Actions 
menu. Available download formats depend upon your installation and report 
definition. Supported formats include comma-delimited file (CSV) format, HTML, 
Email, Microsoft Excel (XLS) format, Adobe Portable Document Format (PDF), and 
Microsoft Word Rich Text Format (RTF). 

To download a report:

1. Click the Actions menu and select Download.

2. Select a report download format and follow the provided instructions.

Subscribing to Emailed Reports
End users can receive updated versions of a report by subscribing to it. To subscribe to 
a report, click Subscription on the Actions menu.

To utilize Subscription:

■ An Oracle Application Express administrator must configure email at the Instance 
level.

■ The application developer must enable the Subscription check box on the 
Interactive Report Attributes page. See "Customizing the Interactive Report Search 
Bar" in Oracle Application Express Application Builder User's Guide.

To receive updated report results by email:

1. Click the Actions menu and select Subscription.

The Add Subscription region appears.

2. Under Add Subscription:

Tip: The ability to download an interactive report is configurable by 
your application developer. To learn more about configuring 
download options, see "Configuring Download Options on the 
Actions Menu" in Oracle Application Express Application Builder User's 
Guide.
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a. Email Address - Enter the email addresses to receive the report. To include 
multiple email addresses, separate each email address with a comma.

b. Subject - Enter text to display in the email subject line.

c. Frequency - Select the interval at which the report is sent.

d. Starting From - Select a start date and time.

e. Ending - Select a end date and time. Select a day, week, month, or year.

f. Click Apply.

See Also:  "Managing Interactive Report Subscriptions" in Oracle 
Application Express Administration Guide
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4About Uploading Data

This section describes how to import data into an Oracle Application Express 
application using an existing application Data Loading Wizard. 

Topics:
■ About Using the Data Loading Wizard

■ Importing Data from a File into Your Application

■ Copying and Pasting Data into Your Application

■ Automatically Supported Date, Timestamp and Number Formats

About Using the Data Loading Wizard
Applications with data loading capability enable end users to dynamically import data 
into a table within any schema to which the user has access. To do this, end users run a 
Data Load Wizard that uploads data from a file or copies and pastes data entered by 
the end user directly into the wizard.

The Data Loading wizard for your application may have been built to include the 
ability to apply table lookup and transformation rules during the data upload process. 
Before the data is actually imported into the database, you are given the opportunity 
to review the data after all look up and transformation rules have been applied.

■ Table Lookups - These rules automatically map data in the import file or copy and 
paste field to data that is found in another table. For example, if the import file 
contains a department name for the DEPTNO column but the upload table 
requires a number for that column, use a table lookup rule to find the 
corresponding department number for that department name in another table.

■ Data transformation rules - These rules automatically perform formatting 
transformations such as changing import data to uppercase, lowercase, and so on. 
For example, if the import file includes column data with both upper and 
lowercase and the destination table requires all uppercase, data transformation 
rules can automatically insert only uppercase into that column during data upload

Tip: In order to use the functionality described in this section, your 
application must have been built with Data Upload capability. To 
learn more, see "Creating Applications with Data Loading Capability" 
in Oracle Application Express Application Builder User's Guide.
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Importing Data from a File into Your Application
In order to upload data to your application, the application must have been built with 
Data Upload capability and the file must be formatted properly.

To illustrate how you can use the Data Load wizard to import data from a text file, the 
following section demonstrates the upload process and includes examples from the 
sample database application, Product Portal.

To import data from a file into your application:

1. Log into your application.

2. Launch the Data Load wizard. 

The first page of the Data Load wizard appears.

3. For Import From, select Upload file, comma separated (*.csv) or tab delimited.

The Data Load Source page appears with options for loading from a data file. The 
following example shows an example Data Load Source page for the Sample 
Application.

4. For Data Source Load, make the following additional selections and entries:

a. File Name - Browse to or enter the path and file name containing the data to 
upload.

The following example shows an example customer.txt data load file. 

b. Separator - Enter the column separator character. Use \t for tab separators.
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c. Optionally Enclosed By - Enter a delimiter character if you want to delineate 
the start and end boundary of a data value.

d. First Row has Column Names - Select Yes if your data contains column names 
in the first row.

5. For Globalization, make the following entries:

a. Currency Symbol - If your data contains an international currency symbol, 
enter it here. For example, if your data has "$1,234.56" or "¥1,234.56", enter $ or 
¥. Otherwise the data may not load correctly.

b. Group Separator - If your data contains a group separator enter it here. A 
group separator is a character that separates integer groups, for example to 
show thousands and millions.

Any character can be the group separator. The character specified must be 
single-byte, and the group separator must be different from any other decimal 
character. The character can be a space, but cannot be a numeric character or 
any of the following: plus (+), hyphen (-), less than sign (<), or greater than 
sign (>).

c. Decimal Character - If your data contains a decimal character, enter it here. 
The decimal character separates the integer and decimal parts of a number.
Any character can be the decimal character. The character specified must be 
single-byte, and the decimal character must be different from any other group 
separator. The character can be a space, but cannot be a numeric character or 
any of the following: plus (+), hyphen (-), less than sign (<), or greater than 
sign (>)

6. Click Next.

The Data/Table Mapping page appears.

The example below is an example Data/Table Mapping page after importing data 
from the customer.txt file.

7. For Data/Table Mapping, make the following selections and entries:

a. Column Names - The destination column name that will be uploaded with the 
data in this column. 

If the first row does not contain the column names and the First Row has 
Column Names option was set to Yes, the Column Names fields will be 
populated with the column names from the first row of the upload data file. 
You can change these names by selecting the destination column name this 
data will be uploaded to, or set to do not load if you do not want to upload 
data in this column.

If the First Row has Column Names option was not set to Yes, the column sets 
the default to do not load. In this case you need to select from the drop down 
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list for each column name, the name of the column this data will be uploaded 
to.

b. Date/Number Format - Most of the standardized date and number formats 
are automatically parsed and then passed to the database. If you want to 
define your own format or the format is not an automatically parsed format, 
use this field to define your own. See "Automatically Supported Date, 
Timestamp and Number Formats" on page 8.

8. Click Next.

The Data Validation page appears showing the data that will be inserted or 
updated after any table lookup and transformation rules have been applied. For 
more information regarding table look up and transformation rules, see "About 
Using the Data Loading Wizard" on page 4-1.

The following illustration shows that once the data from the customer.txt file is 
uploaded, customer information for Edward Logan will be updated and three new 
customers will be added.

9. For Data Validation, review the data to be uploaded and click Load Data.

The Data Load Results page appears.

This illustration shows the Data Load Results page after the Sample Application 
has imported the data contained in the customer.txt file.

10. The Data Load Results page shows the following:

■ Inserted Row(s) - This is the number of new rows uploaded to the table.

■ Updated Row(s) - This is the number of rows in the table updated with new 
information.

■ Failed Row(s) - This is the number of rows from the upload file that were not 
added or updated. 

11. Click Finish to exit the wizard.
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Copying and Pasting Data into Your Application
In order to upload data to your application, the application must have been built with 
Data Upload capability and the pasted data must be formatted properly.

To illustrate how you can use the Data Load wizard to import data from a text file, the 
following section demonstrates the upload process and includes an illustration of the 
sample database application, Product Portal.

Follow these steps to cut and paste data into your application:

1. Log into your application.

2. Launch the Data Load wizard.

The Data Load Source page of the wizard appears.

The following illustration shows an example Data Load Source page. 

3. For Data Source Load, make the following selections and entries:

a. Import From - Select Copy and Paste.

b. Separator - Enter the column separator character. Use \t for tab separators.

c. Optionally Enclosed By - Enter a delimiter character if you want to delineate 
the start and end boundary of a data value. 

d. First Row has Column Names - Select Yes if your data contains column names 
in the first row.

e. Copy and Paste Delimited Data - Copy the data to be uploaded with the 
appropriate delimiters and paste into this field.
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The following is an example Data Load Source page after data from the 
customer.txt file has been copied and pasted in to the Copy and Paste 
Delimited Data field.

4. For Globalization, make the following entries:

a. Currency Symbol - If your data contains an international currency symbol, 
enter it here. For example, if your data has "$1,234.56" or "¥1,234.56", enter $ or 
¥. Otherwise the data will not load correctly.

b. Group Separator - If your data contains a group separator enter it here. A 
group separator is a character that separates integer groups, for example to 
show thousands and millions.

Any character can be the group separator. The character specified must be 
single-byte, and the group separator must be different from any other decimal 
character. The character can be a space, but cannot be a numeric character or 
any of the following: plus (+), hyphen (-), less than sign (<), or greater than 
sign (>).

c. Decimal Character - If your data contains a decimal character, enter it here. 
The decimal character separates the integer and decimal parts of a number.
Any character can be the decimal character. The character specified must be 
single-byte, and the decimal character must be different from any other group 
separator. The character can be a space, but cannot be a numeric character or 
any of the following: plus (+), hyphen (-), less than sign (<), or greater than 
sign (>)

5. Click Next.

The Data/Table Mapping page appears.

The following is an example Data/Table Mapping page after copying and pasting 
data from the customer.txt file.
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6. For Data/Table Mapping, make the following selections and entries:

a. Column Names - The destination column name that will be uploaded with the 
data in this column. 

If the first row does not contain the column names and the First Row has 
Column Names option was set to Yes, the Column Names fields will be 
populated with the column names from the first row of the upload data file. 
You can change these names by selecting the destination column name this 
data will be uploaded to, or set to do not load if you do not want to upload 
data in this column.

If the First Row has Column Names option was not set to Yes, the column 
names default to do not load. In this case you need to select from the drop 
down list for each column name, the name of the column this data will be 
uploaded to.

b. Date/Number Format - Most of the standardized date and number formats 
are automatically parsed and then passed to the database. If you want to 
define your own format or the format is not an automatically parsed format, 
use this field to define your own. See "Automatically Supported Date, 
Timestamp and Number Formats" on page 8.

7. Click Next.

The Data Validation page appears showing the data that will be inserted or 
updated after any table lookup and transformation rules have been applied. For 
more information regarding table look up and transformation rules, see "About 
Using the Data Loading Wizard" on page 4-1.

The following illustration shows that once the data from the customer.txt file is 
uploaded, customer information for Edward Logan will be updated and three new 
customers will be added.

8. For Data Validation, review the data to be uploaded and click Load Data.
The Data Load Results page appears.

The following illustration shows the Data Load Results page after the Sample 
Application has imported the data contained in the customer.txt file.



Automatically Supported Date, Timestamp and Number Formats

4-8 Oracle Application Express End User's Guide

9. The Data Load Results page shows the following:

■ Inserted Row(s) - This is the number of new rows uploaded to the table.

■ Updated Row(s) - This is the number of rows in the table updated with new 
information.

■ Failed Row(s) - This is the number of rows from the upload file that were not 
added or updated. 

10. Click Finish to exit the wizard.

Automatically Supported Date, Timestamp and Number Formats
During the data upload process the following date, timestamp and number formats 
are automatically parsed and passed to the database. 

Automatically Supported Date Format Masks
'MM/DD/RRRR'

'DD/MM/RRRR'

'DD/MM/RR'

'fmMM/DD/RRRR'

'fmDD/fmMM/RRRR'

'RRRR.MM.DD.'

'DD-MM-RR'

'DD.MM.RRRR'

'DD/MON/RR'

'RRRR-MM-DD'

'DD-MM-RRRR'

'fmDD/MM/RRRR'

'RRRR/MM/DD'

'DD.MM.RR'

'fmRRRR/MM/DD'

'fmDD.MM.RRRR'

'MM/DD/RRRR'
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'RRRR.MM.DD'

'fmDD-MM-RRRR';

'RRRR-MM-DD"T"hh24:mi:ss'

Automatically Supported Timestamp Format Masks
'DD/MM/RR HH24.MI.SSXFF'

'DD.MM.RR HH:MI:SSXFF PM'

'DD/MM/RR HH:MI:SSXFF PM'

'DD-MON-YYYY HH24:MI'

'DD-MON-YYYY HH24.MI.SSXFF'

'DD-MON-YYYY HH:MI:SSXFF PM'

'DD-MON-YYYY HH24:MI TZR'

'DD-MON-YYYY HH24.MI.SSXFF TZR'

'DD-MON-YYYY HH.MI.SSXFF PM TZR'

Automatically Supported Number Format Masks
'FML999G999G999G999G990D00'

'999G999G999G999G990D00'

'999G999G999G999G990D0000'

'999G999G999G999G999G999G990'

'999G999G999G999G990D00MI'

'S999G999G999G999G990D00'

'999G999G999G999G990D00PR'
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